DMHRSi EAS Processing Outline


	TASK
	FREQUENCY/DESCRIPTION
	COMPLETED Y/N

	1.  Run DoD Employees Missing Payroll Data

[image: image1.emf]Run Payroll  Reconciliation Reports.docx


	Bi-Weekly

a.  Resolve all issues  and note on spreadsheet


	

	2.  Run Army Payroll Validation
	Bi-Weekly

a.  Resolve all issues and note on spreadsheet


	

	3.  Run Distribute Labor Costs 

[image: image2.emf]Distribute Labor  Costs.docx


	Bi-Weekly (once you have validated that DCPS payroll has been received by DMHRSi for that pay period)

a.  Resolve all “missing cost rate errors”
	

	4.  Run DoD Batch and Timecard Status Report
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	Bi-Weekly checking for the following:

a.  All timecards are in the correct status

b. All employees have the organization and assignment category populated


	

	5.  Run and validate the Assigned Personnel Report
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	Monthly
	

	6.  Run and validate the EAS Summary View Report
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	Monthly
a.  Validate that all dual component employees on the Assigned Personnel report show in the EAS Summary View

b. Validate all personnel data elements

c. Validate workload against hours charged

d. Validate that all available and nonavailable hours have cost as appropriate

	

	7.    Run Distribute Labor Costs again
	Monthly – always run it again through the last pay period that was received before creating the EAS interface file

	

	8. Create the EAS Interface File
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	Monthly
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Reference: DMHRSi Glossary List

[bookmark: ZZZ_TUT_1]Scope

This procedure covers The PRC: Distribute Labor Cost program in DMHRSi.

This program will calculate and apply costs to employee timecards that have been entered into LCA.

[bookmark: ZZZ_TUT_2]Policy 

The PRC:  Distribute Labor Cost program should be run monthly at the close of business.

Monthly close process must run in accordance with Service Specific Policy and Guidelines.  Refer to LCA Monthly Sequence of Events.

[bookmark: ZZZ_TUT_3]Responsibility

Responsibilities within DMHRSi are "Role" based.  All roles are responsible for monitoring self-service worklist and notifications.  Refer to Manage Your Worklist. Your Role is defined by your assignment within your organization and reflects your security levels within DMHRSi.   The following roles may be assigned to any individual within an activity responsible for competing the following:

The DMHRSi Project Office is responsible for ensuring that the tasks defined are consistent with actual application functionality.

The DMHRSi Subcommittee is responsible for ensuring that the Policy and Responsibilities set forth in this document are consistent with Service policy and/or guidance.  

The DMHRSi LCA Exceptions Manager is responsible for costing employees that are outside of the specialist/manager role.

The LCA Specialist is responsible for running the PRC: Distribute Labor Cost concurrent program.

The LCA Manager is responsible for identification of inaccuracies and making necessary corrections and/or adjustments as required, and running close processes within the DMHRSi application.

[bookmark: ZZZ_TUT_4]Distribution

DMHRSi Configuration Control Board

DMHRSi LCA Exceptions Manager

DMHRSi Project Office

DMHRSi Sub-Committee

LCA Manager

LCA Specialist*

LCA Timekeeper Specialist

Supervisor

[bookmark: ZZZ_TUT_5]Ownership

The DMHRSi Configuration Control Board is responsible for this document.  Changes to this document must follow the DMHRSi Configuration Management Process with final approval authority being the DMHRSi Configuration Control Board.

[bookmark: ZZZ_TUT_6]Activity Preface

All hours for the week and/or month must be submitted, approved, and imported into the Projects tables.  Refer to Documenting and Submitting Time: Create a Timecard; Documenting and Submitting Time for GME or GDE Program Students; and Submit Time via Pre-Approved Batches.

Prior to the month-end reporting to EASIV, DCPS files must be received and loaded into DMHRSi.

When costing an employee assigned within the same facility, you can use the Specialist responsibility.  To cost time for an employee within the same Service, but from a different facility, you can use either the LCA Manager or the DMHRSi LCA Exceptions Manager responsibility.  To enter time for an employee from another Service, you must use the DMHRSi LCA Exception Manager responsibility.  

Warning:  If any project expenditure or labor costs rate has been split, you must recalculate raw costs and the PRC: Distribute Labor Cost concurrent program must be run to recalculate the split.   Refer to Distribute Labor Costs  for procedures on running the Distribute Labor Cost concurrent program.    Note:  If you split time to the same project, you do not need to run the PRC: Distribute Labor Costs Request; you just need to recalculate raw costs.

Log on to DMHRSi by typing in your assigned User Name and Password.  If you do not have an assigned account, please contact your Site Application Administrator (SAA).

Since all entered data is case sensitive, turn the "CAPS LOCK" on now.

[bookmark: ZZZ0001][bookmark: ZZZ_TUT_7]LCA Specialist

[bookmark: ZZZ0002][bookmark: PRC]1. Run the PRC: Distribute Labor Cost program.

· Start the task using the "[Service] LCA Specialist" responsibility. 

Note:   This task also may be accomplished by using the "[Service] LCA Manager" or the "DMHRSi LCA Exception Manager" responsibility.   Refer to the Activity Preface to determine the level of responsibility needed.

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO110LC_temp_image002.jpg]

· Select the "Submit Process and Reports" option under the Process and Reports node to open the "Submit a New Request" form. 

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO110LC_temp_image004.jpg]

The "Single Request" option is highlighted by default.

· Click the "OK" button. 

The "Submit Request" form displays.  

[bookmark: ZZZ0003]2. Run the PRC:  Distribute Labor Costs. 

· Type "%DISTR%" in the "Name" field and press the [TAB] key.  

· You can also click the LOV icon [ [image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO110LC_temp_image006.jpg]] to the right of "Name" field to open the "Reports" find form.  Type "%DISTR%" in the "Find" field and click the "Find" button to narrow the search.  

· If there is more than one matching record, then select "PRC:  Distribute Labor Costs" from the list and click "OK" button. 

The "Name" field will populate with "PRC:  Distribute Labor Costs" and the "Parameters" form will open.

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO110LC_temp_image008.jpg]

· Optionally Enter the Expenditure Batch. 

All timecards in DMHRSi are assigned a batch name.  Refer to Adjust Approved Time  for more information on expenditure batches.

· Enter the Project Number (required parameter). 

· You can also click the LOV icon [ [image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO110LC_temp_image006.jpg]] to the right of the "Project Number" field to open the "Longlist" find form.  Type the "project number" in the "Partial Value" field and click the "OK" button. 

· Optionally enter the “Employee Name.” 

· Enter the End Date.  When an end date is entered, it must be equal to a Civilian Pay Period End Date.  This is a Saturday, for example.  When running the program for the month of August 2004, enter the payroll period end date of Saturday 04-Sep-2004.  This is the payroll period end date that includes the last week of August 2004. 

Note:  The end date is not a required parameter and may be left blank, but this is not recommended.  If the end date is left blank, cost is distributed for all timecards that have been entered, but no cost is distributed as of the date the program is run. 

· Leave all other parameters blank. 

· Click the "OK" button to accept the parameters and return to the Submit Requests form. 

The "Submit Request" form will open with the supplied information.

[bookmark: ZZZ0004]3. Run the program.

· On the "Submit Request" form, click the "Submit" button. 

The "Requests" form is displayed with the request as in "Pending" phase.

· Click the "Refresh Data" button to refresh the status of the programs.  Continue to click on the "Refresh Data" button until the status changes to "Complete.” 

· Highlight the "Request ID" for the desired report and click the "View Output" button. 

Note:  The report will show all employee labor that has been successfully costed as well as that which was not.  Rejected hours will be displayed in the "Labor Cost Exception" section of the report with an associated “Rejection Reason.”  This reason should be used as a guide to resolve the problem.  Once necessary corrections have been made, re-run the “PRC:  Distribute Labor Cost” program.  (See: Run the PRC:  Distribute Labor Cost report.)

[bookmark: ZZZ0005]4. Close the forms.

· Click the "Oracle Application" icon in the upper left hand corner of the "Report" form and choose "Close" from the list. 

· Click the "Oracle Application" icon in the upper left hand corner of the "Requests" form and choose "Close" from the list. 

You will return to the main screen, Navigator.

[bookmark: ZZZ0006]5. Exit the Oracle Application.

· Select File > Exit Oracle Applications from the menu. 

[bookmark: ZZZ0007]End of activity.



[bookmark: TUT_FLOWCHART_1][bookmark: ZZZ_TUT_8][image: Distribute Labor Costs: Flowchart]
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Determining Timecard Statuses 

Top of Form

Quick Link 

Bottom of Form

Reference: DMHRSi Glossary List

[bookmark: ZZZ_TUT_1]Scope

This procedure covers the process for running the Missing Timecards Report and the DoD and Batch Timecard Status Report via the DMHRSi application or the Timecard Status Report through Discoverer. 

The Missing Timecard Reports through DMHRSi allows you, the user, to:

· To identify those timecards not yet submitted. 

· To run the report for all organizations within your facility or individual organizations. 

· To run a report for an individual Supervisor. 

· To run a report for an individual Employee. 

The DoD and Batch Timecard Status Report through DMHRSi allows you, the user, to:

· Have the ability to export data from DMHRSi. 

· Enter parameters for the report that will be based on the user’s security profile. 

· Select timecard data with Date Ranges, Organization Parent DMIS ID, Group Parent DMIS ID, and Group Name. 

· Have the ability to report off multiple pay periods. 

· Have the ability to include all Payrolls (time is collected in weekly (when batched), bi-weekly, and monthly intervals), regardless of time entry frequency, should be returned based upon parameters. 

· Report Dual Component Assignment Details (the assignment details on the report should be returned based upon the person type defined in the timecard for each payroll period).   

· Report Null or unsubmitted timecards (For individuals with null (or unsubmitted) timecards, report should be returned with pay period dates and the status of “not submitted.” 

· Distinguish between assignment types, allowing the user to distinguish between primary, secondary, and/or reserve guard assignments. 

· Have the Ability to identify time reporting requirements. 

· Define the Assignment Category (assist the user in being able to distinguish between full time regular and GME/GDE). 

· Identify who entered time (i.e. submitter name, using timecard entry or created by through pre-approved batch entry).   

· Prevent the user from entering incorrect dates.    

· Report Reserve or Guard (Single component) employees. 

· Report the same output as EASIV (all records should match when comparing the population against EASIV).  

· Report Assignment Details:  The Timecard status should be returned based on the assignment details on the last day of the pay period.  If there are multiple assignment records within the start and end date of the timecard period, all attributes should be returned as the timecard period end date. 

The Bi-Weekly Timecard Status Report through Discoverer allows you, the user, to:

· Simultaneously run the report for more than one organization within your facility or individual organizations. 

· Run a query to include the Parent Organization and their subordinate organizations and to include multiple time periods. 

· Run timecard status report over multiple time periods.  As a result, individuals may have more than one row, representing each timecard which falls within the reporting period.  The requested period is displayed at the top of the report, and the actual date is displayed in the rows.  A timecard is included in the report if any of the portion time falls within the report requested dates. 

· If you desire a requested “Timecard Period,” make sure the report start and end dates match the timecard period exactly.  The report will not show additional rows for missing timecards if at least one timecard exits within the requested reporting period.  If you request a period that covers two timecard periods and the employee has only one timecard, it will simply show one timecard.  If both timecards are missing, one timecard will be displayed with blank fields for the timecard data. 

· Run a report for an organization and all its subordinate organizations.  You must enter or select the EXACT parent organization from the list of values.  Wildcards are NOT permitted. 

· This report was designed to produce detailed information of an individual's timecard status.  It displays the employee’s Name, SSN (4), Title/Rank, Service, Organization, People Group, Supervisor, Time Approver, Approval Status Start Time, and End Time.   

[bookmark: ZZZ_TUT_2]Policy

The Missing Timecards Report should be run at the close of business bi-weekly on Mondays (or on Tuesday, if Monday falls on a Federal holiday).

[bookmark: ZZZ_TUT_3]Responsibility

Responsibilities within DMHRSi are "Role" based.  All roles are responsible for monitoring self service worklist and notifications.  Refer to Manage Your Worklist.  Your Role is defined by your assignment within your organization and reflects your security levels within DMHRSi.  The following roles may be assigned to any individual within an activity responsible for completing the following:

The DMHRSi Subcommittee is responsible for ensuring that the Policy and Responsibilities set forth in this document are consistent with Service policy and/or guidance.  

The DMHRSi Project Office is responsible for ensuring that the tasks defined are consistent with actual application functionality.

The LCA Specialist is responsible for running weekly missing timecard reports.  

The LCA Manager is responsible for the identification of inaccuracies and making necessary corrections and/or adjustments.

The LCA Timekeeper Specialist is responsible for verifying that all employees have submitted timesheets and all submitted timesheets have been approved.

The Supervisor is also responsible for verifying that all employees have submitted timesheets and all submitted timesheets have been approved.

[bookmark: ZZZ_TUT_4]Distribution

DMHRSi Configuration Control Board

DMHRSi LCA Exceptions Manager

DMHRSi Project Office

DMHRSi Sub-Committee

LCA Manager

LCA Specialist*

LCA Timekeeper Specialist*

Supervisor*

[bookmark: ZZZ_TUT_5]Ownership

The DMHRSi Configuration Control Board is responsible for this document.  Changes to this document must follow the DMHRSi Configuration Management Process with final approval authority being the DMHRSi Configuration Control Board.

[bookmark: ZZZ_TUT_6]Activity Preface

All hours for the week and/or month must be submitted, approved, and imported into the Projects tables.  Refer to Documenting and Submitting Time: Create a Timecard; Documenting and Submitting Time for GME or GDE Program Students; and Submit Time via Pre-Approved Batches.

Log on to DMHRSi by typing in your assigned User Name and Password.  If you do not have an assigned account, please contact your Site Application Administrator (SAA).  

Since all entered data is case sensitive, turn the "CAPS LOCK" on now.  

[bookmark: ZZZ0001][bookmark: ZZZ_TUT_7]LCA Timekeeper Specialist 

[bookmark: ZZZ0002]1. Verify that all employees have submitted timesheets and that all submitted timesheets have been approved.

Refer to Manage Your Worklist.  

[bookmark: ZZZ0003]LCA Specialist

[bookmark: ZZZ0004]If running the Bi-Weekly Timecard Status Report via Discoverer Navigator, goto task #23. Otherwise, goto task #2.

[bookmark: ZZZ0005]Goto task #10 to run the DoD Batch Timecard Status Report.

[bookmark: ZZZ0006]2. Start the task using the "[Service] LCA Specialist" responsibility. 

Note:  This task may also be accomplished using a “[Service] LCA Manager" or the "DMHRSi LCA Exceptions Manager" responsibility.   

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO108LC_temp_image002.jpg]

· Select the "Submit Process and Reports" option under the Process and Reports node to open the "Submit a New Request" form. 

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO108LC_temp_image004.jpg]

The "Single Request" option is highlighted by default.

· Click the "OK" button. 

The "Submit Request" form is displayed.  

[bookmark: ZZZ0007]If running the DoD and Batch Timecard Status Report, goto task #10.  Otherwise, goto task #3 to run the Missing Timecards Reports.

[bookmark: ZZZ0008]3. Identify missing timecards.

On Monday morning, at the end of each timecard period (or Tuesday, if Monday falls on a Federal holiday), run the "Missing Timecards Report" to identify those timecards that have not been submitted.

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO108LC_temp_image006.jpg]

· Type "%missing%" in the "Name" field and press the [TAB] key.  

· You can also click the LOV icon [ [image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO108LC_temp_image008.jpg]] to the right of "Name" field to open the "Reports" find form.  Type "%missing%" in the "Find" field and click the "Find" button to narrow the search.  

· Select: “Missing Timecards Reports" from the list and click the "OK" button. 

The "Name" field will populate with "Missing Timecards" and the "Parameters" form will open.

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO108LC_temp_image010.jpg]

[bookmark: ZZZ0009]4. Enter parameters.

· Enter From Date: 

· Click in the "From Week Ending Date" field and enter the date for the Sunday of the desired "From" week in DD-MON-YYYY format (Example: 19-JAN-2003). 

· Enter To Date: 

· Click in the "To Week Ending Date" field and enter the date for that Saturday of the desired "To" week in DD-MON-YYYY format (Example: 25-JAN-2003). 

· Enter Define Missing: 

· Click the cursor in the "Define Missing” field and then, click the LOV button to display the "Define Missing” find form. 

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO108LC_temp_image012.jpg].

· Select "Req. and status not equal to Approved."  This is highlighted by default. 

· Click the OK button. 

· Enter Application:  LEAVE THIS FIELD BLANK.  DO NOT ENTER DATA IN THIS FIELD. 

· Enter the Organization Name: 

Note:  If you want to run the report for all organizations within your facility, leave the organization name blank. 

· If you want to run the report for an individual organization within your facility, click the cursor in the "Organization Name" field and enter the full (or partial value) for the Organization Name and press the [TAB] key. 

· If you would like to see a list of values, click in the Organization Name field, hold down the [Ctrl] key on your keyboard and press the "L" key. 

The "Organization Name" find form opens.

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO108LC_temp_image014.jpg]

· In the "Find" field, enter part of the organization name followed by % wildcard.  Use the slide bar on the right hand side of the form to scroll through the list of Organization Names.  Use the up and down arrow keys on your keyboard to move between names. 

· Select an Organization Name by clicking on the name.  Then click the "OK" button to return to the "Parameters" form. 

The "Organization Name" field will be populated.

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO108LC_temp_image016.jpg]

· Optionally enter Location:  

· If you would like to see a list of values, click in the Location Name field.  Hold down the [Ctrl] key on your keyboard and press the "L" key. 

· In the "Find" field, enter the UIC/Parent Unit followed by % wildcard.  Use the slide bar on the right hand side of the form to scroll through the list of Locations.  Use the up and down arrow keys on your keyboard to move between locations. 

· Select a Location by clicking on the name.  Then click the "OK" button to return to the "Parameters" form. 

· Enter Payroll Assignment Set:  LEAVE THIS FIELD BLANK.  DO NOT ENTER DATA IN THIS FIELD. 

· Enter Person Type: 

· Click the cursor in the "Person Type" field and then click the LOV icon to open the "Person Type" find form. 

· Select EMPLOYEE from the list of values 

· Click the “OK” button. 

Note:  If you want to further limit the report output, optionally enter a "Supervisor Name,” "Person Name," or the "Person Number.”

· Optionally enter a "Supervisor Name." 

· Optionally enter a "Person Name.” 

· Optionally enter a "Person Number.” 

· Enter Assignment Type:  Defaults to Active. 

· Enter Supplier:  This field is not used in DMHRSi. 

· Enter Sort option one:  

· Click the cursor in the "Sort Option One" field and then click the LOV button to display the "Sort Option One" find form. 

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO108LC_temp_image018.jpg]

Note:  Once data has been entered in the "Sort Option One" field, the Sort Option Two field will display "up to Sort Option Four."  This allows sorting the report in many different ways. These fields are optional.

· Click the “OK” button. 

The "Submit Request" form will be opened with the supplied information.

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO108LC_temp_image020.jpg]

[bookmark: ZZZ0010]5. Submit the Missing Timecards Report.

· On the "Submit Request" form, click the "Submit" button.  

The "Requests" form is displays with the request in "Pending" phase.

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO108LC_temp_image022.jpg]

Note:  Click the "Refresh Data" button to refresh the "Phase" field.

[bookmark: ZZZ0011]6. View the Missing Timecards Report.

· Click the "Refresh Data" button to refresh the status of the programs.  Continue to click on the "Refresh Data" button until the status changes to "Complete.” 

· Highlight the "Request ID" for the desired report and click the "View Output" button. 

· Review the "Report: Request ID - ###" form containing the missing timecards report. 

· Close the "Report: Request ID - ###" form by clicking the "X" on the upper right hand corner of the form.  You will return to the "Requests" form. 

[bookmark: ZZZ0012]7. Close the forms.

· Select File > Close Form from the menu. 

You will return to the main screen, Navigator.

[bookmark: ZZZ0013]If there are missing timecards, goto task #9.  Otherwise, goto task #8 to end.

[bookmark: ZZZ0014]8. Exit the Oracle Application.

· Select File > Exit Oracle Applications from the menu. 

[bookmark: ZZZ0015]End of activity.

[bookmark: ZZZ0016]9. Notify the workcenter Timekeeper/Supervisor of the missing timecards so that they may work with the employee to get timecard submitted and approved.

[bookmark: ZZZ0017]End of activity.

[bookmark: ZZZ0018]10.    Run the DoD Batch and Timecard Status Report.

Warning:  This task may only be accomplished using a “[Service] LCA Specialist," “[Service] LCA Manager," or the "DMHRSi LCA Exceptions Manager" responsibility.   

· Click in the "Name" field of the "Run This Request” form.  Enter “DoD” followed by a percent wildcard (DoD%) in the “Name” field and press [TAB] key to open the "Reports" form.   

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO108LC_temp_image024.jpg]

Note:  You can also click the LOV icon [ [image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO108LC_temp_image008.jpg]] to the right of the "Name" field to open the "Reports" find form.  Type "DoD%" in the "Find" field and click the "Find" button to narrow the search.

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO108LC_temp_image026.jpg]

· Select “DoD Batch and Timecard Status Report” from the list. 

· Click the "OK" button. 

The “Parameters” form displays.

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO108LC_temp_image028.jpg]

[bookmark: ZZZ0019]11.    Enter the report “Parameters.”

Warning:  This report SHOULD NOT be run for timecard periods that extend over 31 days.

· Enter the Reporting Period Start Date(Required): 

· Click in the “Reporting Period Start Date” field and enter the date for the desired reporting Period in DD-MON-YYYY format (Example: 15-SEP-2006). 

Note:  The end date must be greater than the start date.   The report should provide the user with the ability to query time collection data within a date range.  For example, if the end user enters the date range of 15-SEP-2006 through 15- OCT-2006, timecard information for the following pay periods should be returned:

· September 03, 2006 – September 16, 2006 

· September 17, 2006 – September 30, 2006 

· October 1, 2006 – October 14, 2006 

· October 15, 2006 – October 28, 2006 

· Each employee should have at least one line returned per pay period, unless the employee is of dual component, where no more than two lines should be returned depending upon their organization details.  If no timecard entry exists for the payroll period, the timecard should be returned with a status of “Not Submitted.” 

· GME and GDE records should be returned based on the date range that has been entered as a parameter.   In the scenario described above where end user enters a date range of 15-SEP-2006 through 15- OCT-2006, monthly timecard information for the months of September and October should be returned. 

· New employee records should only be returned for active payroll periods.  For example, if the employment start date is September 15, 2006, and the end user enters a date range of 15-SEP-2006 through 30- OCT-2006, timecard information for the new employee’s pay periods should be returned: 

· September 03, 2006 – September 16, 2006 

· September 17, 2006 – September 30, 2006 

· October 1, 2006 – October 14, 2006 

· October 15, 2006 – October 28, 2006 

· For terminated employee records, timecard periods should be returned for active payroll periods.   For example, if the employment end date is 20-Sep-2006, and the end user enters a date range of 01-SEP-2006 through 30- SEP-2006, timecard information for the following pay periods should be returned: 

· August 20, 2006 – September 02, 2006 

· September 03, 2006 – September 16, 2006 

· September 17, 2006 – September 30, 2006 

· If there are multiple assignment records with in the start and end date of the timecard period, the latest active assignment details available for that pay period should be returned.    For  Example, if a time period beginning and end date is September 03, 2006 – September 16, 2006 and an employee was given a people group change on September 13, 2006, the supervisor values effective September 16, 2006 should be included in the report. 

· Enter the Reporting Period End Date (Required): 

· Click in the “Reporting Period End Date” field and enter the end date for the desired reporting Period in DD-MON-YYYY format (Example: 15- SEP-2006). 

Warning:  In addition to the start and end date, at least one of the below parameters must be entered in order for data to be returned.

Warning:  The user must enter a single DMIS ID in the ORG Parent DMIS ID and the Group Parent DMIS ID fields.  Partial values like “003%” or multiple values like “0032, 0039” will NOT produce output.

· Enter the Org Parent DMIS ID (Optional): 

· Click in the “Org Parent DMIS ID” field and enter the Organization parent DMIS ID (Org Parent DMIS ID allows you to enter the DMIS ID of the Parent department/facility you wish to report). 

· Enter the Group Parent DMIS ID(Optional): 

· Click in the “Group Parent DMIS ID” field and enter the group parent DMIS ID (Group  Parent DMIS ID allows you to enter the Group Parent DMIS ID of the department/facility you wish to report). 

· Group (like) (Optional): 

· Click the "OK" button.  Enter a partial value in the Group Like field (e.g.79%).  Do NOTenter multiple values (e.g. 79%, W%). 

The "Submit Request" form will open and display the requested information.
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· Review Remaining Information. 

Note:  DO NOT change the defaults.

· Language:  The Language field will default to "American English.” 

· At these Times: 

· The Run the Job field will default to "As Soon As Possible.” 

· Upon Completion: 

· Leave the "Notify" field blank. 

· “Print to” defaults to “noprint” (accept the default). 

· On the "Submit Request" form, click the "Submit" button. 

The "Requests" form is displayed and the request is in the "Pending" or “Running” phase.
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· Click the "Refresh Data" button to refresh the status of the programs.  Continue to click on the "Refresh Data" button until the status changes to "Completed." 

[bookmark: ZZZ0020]12.    View the DoD Batch and Timecard Status Report.
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· Highlight the "Request ID" for the desired report and click the "View Output" button. 

Note:  The concurrent program output report displays the “DoD Batch and Timecard Status Report.” 

Warning:  If no data was returned in the “View Output,” refer to the “View Log” to determine the issue for lack of data being returned.
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Note:  If you are going to save this file to your hard drive to print at a later date, change the “Font Size” to 6 or 8 so the report will fit on one page.

[bookmark: ZZZ0021]13.    Copy the File and Save it to your Personal Computer’s Hard Drive.

· Select "Tools"> “Copy File" from your toolbar. 
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The output file is presented in a separate browser window in HTML format.
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Select the File > “Save As” from the menu bar to save the output file to your Personal Computer’s Hard Disk Drive.
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The “Save Web Page” screen will display.
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· Select a directory from the “Save in:” drop down list: 

· File name:  The file name auto populates.  Enter a unique file name or accept the default file name in the File Name field. 

· Save as type:  Select "Text File" from the list of values. 

· Encoding:  Accept the default setting. 

· Press the “Save” button to save the file. 

· Close the HTML form and you return to the Report you request. 

· Close the "Report" form and return to the "Requests" form. 

Warning:  The “DoD Batch and Timecard Status Report” is in a comma delimited format.  You must save as a text file but open using Excel.  To preserve the file, you will need to change from a comma to a semicolon when formatting the file.

[bookmark: ZZZ0022]End of activity.

[bookmark: ZZZ0023]14.    Format the “DoD Batch and Timecard Status Report.”

· Open Excel. 

· Select “File”> “Open” from your toolbar. 
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[bookmark: ZZZ0024]15.    Find and open the text file that you saved. 
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· Click the LOV drop down menu in the “Files of type” field. 

· Select “Text Files” from the list of values to display your “Text” files. 
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· Select the file you wish to import to Excel. 

· Click the “Open” button. 

The Text Import Wizard opens and displays the “Text Import Wizard – Step 1 of 3” screen.
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Note:  The “Text Wizard” has determined that your data is "Delimited."

Accept the defaults.

· Click the Next> button to open the “Text Import Wizard – Step 2 of 3” screen. 
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· Check the Semicolon box. 
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The DoD Batch and Timecard Status Report now displays the following column Headings:

· Full Name:  Displays the employee’s full name from the “Person” form. 

· Employee Number:  Displays the employee’s number from the “Person” form. 

· Title Ranking:  Title/Rank displays employee title found on the “People” form. 

· Service:  Displays the Service found in the “Personal Additional Details” DFF on the “People” form. 

· Organization:  Displays the “Organization” found in the employee’s “Assignment” record. 

· Group:  Displays the “People Group” found in the employee’s “Assignment” record. 

· Location:  Displays the “Location” found in the employee’s “Assignment” record.  

· Supervisor:  Displays the “Supervisor” found in the employee’s “Assignment” record. 

· Timecard Approver:  Displays the Timecard Approver from the organizational details “Time Management” for the employee’s “Group” found in the employee’s “Assignment” record. 

· Person Type:  Displays the employee’s “Person Type” defined in the “Person” form. 

· Component Person Type:  Displays the employee’s “Component Person Type” defined through the “Timecard Entry” form. 

· Assignment Status:  Displays the “Assignment Status” defined in the employee’s “Assignment” record. 

· Assignment Category:  Displays “Assignment Category” found in the employee’s “Assignment” record. 

· Submitter User Name:  Displays the submitter’s name for the timecard entry or batch entry for submitted time. 

· Timecard Status:  Displays the “Timecard Status,” (null = not submitted status.  Other statuses include the following:  approved, rejected, working, and submitted). 

· Time Period Start Date:  Displays the Timecard Period Start date. 

· Time Period End Date:  Displays the Timecard Period End date. 

· Organization APC:  Displays the Army Organization APC. 

· Group APC:  Displays the Army Group APC. 

· Expenditure Ending Date:  Displays the Pre-Approved Batch End Date. 

· Batch Name:  Displays the Pre-Approved Batch Name. 

· Click the Next> button to open the “Text Import Wizard – Step 3 of 3” screen. 
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· Click the “Finish” button. 

The file is imported into Excel.
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Warning:  All reports, folder views, and screen prints generated through DMHRSi (currently in use or future use) must be modified to include the required FOUO (FOR OFFICIAL USE ONLY) marking per DoD 5200.1R, paragraphs AP3.2.2.2.1 and AP3.2.2.2.2, and JMISO directives.  In order to comply with the above requirements, the end user must add the words “FOR OFFICIAL USE ONLY” on the document.  When this information is viewed on-line, it is not subject the FOUO marking requirements.  The View functionality also allows the user to export the information from the electronic folder to Microsoft Excel.  Once this information is exported, it is subject to the FOUO requirements. Because Oracle Views is a COTS functionality that will not be modified, it becomes the responsibility of the end user to ensure the FOUO requirements are fulfilled.  This will be accomplished through the end user adding (FOR OFFICIAL USE ONLY) to the Header and Footer of the document.  Following this procedure will ensure that anytime the document is printed, the FOUO markings will accompany the data.  The markings MUST be in upper case characters and a bold font.  The top markings will be left justified in the header area and the bottom markings will be right justified in the footer area of the front cover, title, all pages, and back cover of all reports.

[bookmark: ZZZ0025]If FOR OFFICIAL USE ONLY displays on the exported file, goto task #17. Otherwise, goto task #16.

[bookmark: ZZZ0026]16.    Enter the (FOR OFFICIAL USE ONLY) markings to the Header and Footer.

· Select "View"> “Header and Footer” from the toolbar. 
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The “Page Setup” page displays.
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· Click the “Custom Header” button. 
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The “Header” page displays.
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Warning:  The markings MUST be in upper case characters and a bold font.  The top markings will be left justified in the header area and the bottom markings will be right justified in the footer area of the front cover, title, all pages, and back cover of all reports.

· Click on the “Font” icon. 

The “Font” page displays.
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· Select the “Bold” from the Font style list of values. 

· Click the “OK” button. 

The “Header” page displays.
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· Click in the “Left Section” header field. 

· Enter (FOR OFFICIAL USE ONLY) using the following guidelines:  The markings MUST be in upper case characters and use a bold font. 

· Click the “OK” button. 

The “Page Setup” page displays.
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· Click on the “Custom Footer” button. 
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The “Footer” page displays.

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO108LC_temp_image077.jpg]

· Click on the “Font” icon. 

The “Font” page displays.
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· Select the “Bold” from the Font style list of values. 

· Click the “OK” button. 

· Click in the “Right Section” footer field. 

· Enter (FOR OFFICIAL USE ONLY) using the following guidelines:  The markings MUST be in upper case characters and use a bold font. 

· Click the “OK” button. 
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· Click the “OK” button. 

Note:  To verify, click the Print Preview button.  You will not be able to see the header or footer until you print the report.

[bookmark: ZZZ0027]17.    Save the file.

· From the toolbar, select File> "Save As” to save the output file to your Personal Computer’s Hard Disk Drive. 
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· Enter a “File name.”  The file name auto populates.  Enter a unique file name or accept the default file name in the File Name field. 

· Click the LOV drop down menu in the “Save as type” field. 
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· Select “Microsoft Excel Workbook” from the list of values. 

· Click the "Save" button. 

Note:  To view data in ascending order by date, go to Data > Sort, Sort by Employee Number (first), Sort by Timecard End Date, and lastly by Expenditure End Date.  This will group all the time card and batch entries into sequential groups.

· Close the “Microsoft Excel Workbook.” 

· Close "Excel.” 

[bookmark: ZZZ0028]Supervisor or LCA Timekeeper Specialist

[bookmark: ZZZ0029]18.    Contact individual(s) with missing timecard to resolve discrepancy.

[bookmark: ZZZ0030]19.    Notify the LCA Specialist when discrepancies have been resolved.

[bookmark: ZZZ0031]LCA Specialist

[bookmark: ZZZ0032]Goto task #3 to re-run Missing Timecards Report to verify that discrepancies have been resolved.

[bookmark: ZZZ0033]End of activity.

[bookmark: ZZZ0034]20.    Review the Discoverer “Bi-Weekly Timecard Status Report.”

· Start by accessing Discoverer Viewer from Internet Explorer at the following URL. 

https://dmhrsidisco.csd.disa.mil.

The “DoD Computer System Policy” message displays.
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· Read the policy and click the “OK”button. 

The “DoD Computer System Policy” message displays.
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· Read the policy and click the “OK”button. 

The “U.S. Department of Defense Military Health System, iDENTITY AUTHENTICATION SERVICES message, This Website has been Public Key Enabled” selection page displays.  
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Select one of the appropriate methods of use to access the application.

If you have an active DoD Common Access Card, select: 

· CAC Access:   This will validate the use of CAC access to the application. You must have a valid PKI certificate, a trusted PKI Common Access (CA) certificate should be installed, and CAC middleware must be installed and configured properly on your work station (only applicable if you are using a DoD common access card). 

If you do not have a DoD Common Access Card or if your card is not functioning properly, select:

· If you don’t have a CAC, click here:  If you do not have a CAC Card or if your CAC card is not working properly, you can still logon directly by using your Username and Password. 

[bookmark: ZZZ0035]If validating your CAC card, goto task #21. Otherwise, goto task #22.  To bypass the CAC card, enter your Username and Password directly.

[bookmark: ZZZ0036]21.    Validate your CAC Card to access the application. 
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· Click the “CAC Access” button. 

The “Choose a digital certificate” displays.
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· Select the appropriate certificate. 

· Click the “OK” button. 

The “ActivClient Login” form displays.  
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· Enter your PIN number in the “Pin” field. 

· Click the “OK” button. 

Warning:  If your DoD CAC was not validated, click the back button on the browser to return to the CAC selection page to access the application using the “If you don’t have a CAC, click here” option.

[bookmark: ZZZ0037]Goto task #23.

[bookmark: ZZZ0038]End of activity.

[bookmark: ZZZ0039]22.    Bypass your CAC Card to access the application’s Username and Password.
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· Click the “If you don’t have a CAC, click here” link. 

[bookmark: ZZZ0040]23.    Login to Discoverer Viewer.

The “Discoverer Viewer” page opens.
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· Connect To:  Accept the default “Oracle Applications” from the list of values. 

· User Name:  Enter your DMHRSi Applications User Name. 

· Password:  Enter your DMHRSiApplications Password. 

· Database:  Enter the Database as “PROD.” 

· Press the “Go” button. 
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· Start the task using the "[Service] LCA Specialist" responsibility. 

Note:  This task may also be accomplished by using the "LCA [Service] Manager,” or the “DMHRSi LCA Exceptions Manager” responsibility.

· Click the Continue button. 

· The "Workbook" form displays. 

Workbook Result List will be collapsed on your initial entry to Discoverer.

The "Worksheet List" form displays.
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· Open the “Discoverer Workbooks” list by clicking on the “Expand All” link. 
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· Select the workbook based on the column "Name" and “Description” by clicking on its title. 

· Select the “Bi-Weekly Timecard Status” workbook by clicking on the blue arrow next to the workbook name. 
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Listed are the worksheets within the workbook you have opened.  

Note:  Refer to the “Notes” worksheet link for helpful hints on how to apply the parameters.

· Select the “Bi-Weekly Timecard Status” from the available worksheets. 

The “Bi-Weekly Timecard Status Report – Bi Weekly Timecard Status” worksheet displays.
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· Report Start Date: This parameter is looking for the “Report Start Date” for the Timecard Status Report.  It allows you to enter the Timecard period that you wish to report. 

Note:  The timecard status report can now run over multiple time periods.  As a result, individuals may have more than one row, representing each timecard which falls within the reporting period.  The requested period is displayed at the top of the report, and the actual date is displayed in the rows.  A timecard is included in the report if any of the portion time falls within the report requested dates.

Note:  If you desire a requested “Timecard Period,” make sure the report start and end dates match the timecard period exactly.  The report will not show additional rows for missing timecards if at least one timecard exists within the requested reporting period.  If you request a period that covers two timecard periods and the employee has only one timecard, it will simply show one timecard.  If both timecards are missing, one timecard will be displayed with blank fields for the timecard data.

· Enter the Date using the DD-MMM-YYYY format (11-JAN-2005). 

· Report End Date: This parameter is looking for the “Stop Time” for the timecard period.  It allows you to enter the Timecard period end date that you wish to report. 

· Enter the Report End Date using the DD-MMM-YYYY format (21-JAN-2005). 
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· People Group Name Like: People Group Name allows you to enter single or multiple people groups (Department) of the individual’s time card that you wish to report. 

Note:  If you would like a report for your entire facility, enter a % wild card in the group,  the exact parent command in the “Parent Organization Equals” field, and enter a “Y” in the include “Subordinates” field.

· Click the “People Group Name” find icon [ [image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO108LC_temp_image112.jpg]]. 

The “Search and Select: People Group Name Like” page displays.
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· Search by:  Select a search parameter. 

· Click on the drop down list icon [ [image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO108LC_temp_image116.jpg]]. 

· Select search criterion (Recommend “Starts with”). 

· Search for:  Enter the People Group name (or a portion of the name) followed by the “%” wildcard (e.g. 10MDG%, W2MSAA%, 61337%). 
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· Case Sensitive:  Use this check box to specify whether you want to match upper and lower case letters exactly when searching (e.g. when selected, the search term 'New York' would find 'New York', but would not find 'NEW YORK', 'new york', or 'new York').   Recommend that you do not check this box. 

· Click the “Go” button. 

The “Search and Select:  People Group Results” now displays the data that meets your search criteria.
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Note:  If multiple pages of search results exist, use the “Next” [ [image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO108LC_temp_image122.jpg]] link to advance to the next page of results.

· Select a People group from the list. 
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· Available: 

· Click in the Available section. 

· Click on the people group to highlight your choice. 

Note:  You can select more than one value by pressing the Ctrl key and clicking another value. 
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· Click the “Move” icon [ [image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO108LC_temp_image128.jpg]] to move your choice to the “Selected” section. 
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· Click the "Select" button [ [image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO108LC_temp_image132.jpg]]. 

You are returned to The “Bi Weekly Time Status – Bi-Weekly Timecard Status” displaying your selection.
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· Parent Organization Equals: Parent Organization Equals allows you to enter the Organization of individuals you wish to report. 

Note:  Defaults to DOD BUSINESS GROUP.  Accepting the default will display the hierarchy from the top down.

Warning:  To run a report for an organization and all its subordinate organizations you must enter or select from the list of values the EXACT parent organization.  Wildcards are NOT permitted.

· Click the “Parent Organization Equals” find icon [ [image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO108LC_temp_image112.jpg]]. 

The “Search and Select: “Parent Organization Equals” screen displays.
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· Search by:  

· Select a search parameter. 

· Click on the drop down list icon [ [image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO108LC_temp_image116.jpg]]. 

· Select search criterion (Recommend “Starts with”). 

· Search for: Enter the People Group name (or a portion of the name) followed by the “%” wildcard. (e.g. 10MDG%, W2MSAA%, 61337%). 

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO108LC_temp_image138.jpg]

· Case Sensitive:  Use this check box to specify whether you want to match upper and lower case letters exactly when searching (e.g. when selected, the search term 'New York' would find 'New York', but would not find 'NEW YORK', 'new york', or 'new York').   Recommend that you do not check this box. 

· Click the “Go” button. 

Search and Select: People Group Name Like now displays the data that meets your search criteria.

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO108LC_temp_image140.jpg]

Note:  If multiple pages of search results exist, use the “Next” [ [image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO108LC_temp_image122.jpg]] link to advance to the next page of results.

· Select a Parent Organization group from the list. 

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO108LC_temp_image142.jpg]

· Click the “Radio button” icon [ [image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO108LC_temp_image144.jpg]] to highlight your choice. 

· Click the "Select" [ [image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO108LC_temp_image132.jpg]] button. 

You are returned to your selection on the “Timecard Status Report – Timecard Status” screen.

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO108LC_temp_image146.jpg]

· Include Subordinates (Y or N): 

· Enter “Y” if you want a report for all the subordinates of the organization you entered as the “Parent Organization.” 

· Enter “N” if you want a report for only the organization entered as the “Parent Organization.” 

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO108LC_temp_image148.jpg]

· Click the “Go” button. 

The following screen will appear to give you an indication of the progress of the request.

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO108LC_temp_image150.jpg]

When the request has been processed and the report is ready, it will be displayed. 

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO108LC_temp_image152.jpg]

Explanation of Report Fields

· Title of Report: Bi-Weekly Timecard Status 

· Last Run Date:  Date when the report was last run. 

· Actions: 

· Rerun the query:  Use this link to query the database and display the data for the current worksheet. 

· Save as:  Not  used in Discoverer Viewer. 

· Revert to Saved:  Not used in Discoverer Viewer. 

· Printable Page: 

· Export:  Use this link to export the current worksheet for users to open using other applications.  A number of different formats are available. 

· Send as Email:  Not used in Discoverer Viewerer. 

· Worksheets Options:  You can select display options to use in worksheets. For example, whether to display or hide the worksheet title. 

The "Worksheets" form is still active.

· Upon completion, perform one of the following actions: 

· To run another report, simply select another worksheet from the current report displayed. 

· Click the “Workbook” link in the left hand corner of the "Worksheets” form to navigate back to the “Worksheet List” page. 

· Click the "Exit" link in the upper right corner of the "Worksheets" form to exit. 

Note:  For detailed instructions on how to generate standard DMHRSi reports, refer to Discoverer Reports on the Web – Instructions for the Discoverer User.

[bookmark: ZZZ0041]24.    Exit Discoverer 4i Viewer.

· Click the "Exit" icon in the upper right corner of the "Worksheets" form. 

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO108LC_temp_image154.jpg]

[bookmark: ZZZ0042]End of activity.



[bookmark: TUT_FLOWCHART_1][bookmark: ZZZ_TUT_8][image: Determining Timecard Statuses: Flowchart]



[bookmark: TUT_FLOWCHART_2][image: Determining Timecard Statuses: Flowchart]



[bookmark: TUT_FLOWCHART_3][image: Determining Timecard Statuses: Flowchart]

Effective: 01/08/08

Revision: 1.6.4.0



Copyright © 2004 Your Company. All rights reserved.

Oracle® Tutor   Copyright © 1997, 2004, Oracle. All rights reserved.



image75.jpeg







image76.jpeg

ORACLE Diemore Viewer
s e
frerpreren

Timecard Status Repot- TimscardSatus

[e————

Worshars
kg f—

= ity

L Ry

Ea— Rt SO 11205

o v
e O SO

st VeI | f
e S—

vpetnson. st |
o—

e et e O S

&)







image77.jpeg

CRACLE G

ey

B Tmcu St Snet T S

ot
-
=

.

T







image78.jpeg

Tt SR

o)

() )







image79.jpeg







image80.jpeg

Loggedout







image81.gif

Running 5
esky Tiecara™, =
{ stus Repor v

Y !
Sl

(

LCA Specialist

T
Joevie] LCA
Spaciaist
responsiiy. @)

| —







image82.gif

ne S
—_ 2 =
E . :
Parameters” (1) OFFICIAL USE t
= (P | o
mtosd S S
e o
it | e,
progetest
= o e
S
L
e ek spent
=
e
= S
: :
=% B

Vadtng your
ey







image83.gif

LCA Specialist

Loginto Dscoverer |

- £t Dasoverer 4
Viever. 24)







image2.jpeg

- TR Sy LCA Spoclalir 23
e

sk St Ognizsion
Descision

@ iz tansoe:

View: Wiorls

LY

View: L
@







image3.jpeg

Whatyp of rquest do you want o un?
Ssingle Boquest
s aows youto st an il e,

#RequestSet

This alows you 0 subrit s prs-defined s of
roqests







image4.jpeg

O Submit Request

T

s Fl
S ————————— |
|

crET T

Attheso Tines...

LU As Soon o Possble [ ]

Upon Completon..
e O s






image5.jpeg







image6.jpeg

Parameters

Date From
DateTo
Define Missing

Appicaton
Organizsion

Locaton

Payol Assignment St
Poyol Nome

Person Type
SupenisorNarne
Person Name

Person Number

Assignment Type

Suppler
Sort Option One.







image7.jpeg

Req with no Enties

Rea wih no Entries and Working Status
Rea.with no Entries, Warking and Rejected Status







image8.jpeg

023 MBULATORY PROCEDUREUNT
0232ATONCALPATHOLOGY
AESTHESOL061
240061

S HLHHELLIESS SERVCES
O235USNESS OPERATONS
02305001051

23 HROPACTI DEPT
0230UNCALPATHOLOSYLISORATORY
023COWBNED FUD CPERATONS.
1023 COMUND SUTE
0232C0NTROUER

023U FUTREALOCATONS
0BT
20EPLONENT PN RO KON
O2OBNTOLOY







image9.jpeg

Aot
L o AL HOSPITAL RS ONVLLE

Lt 0]

Pami st St
Fapitans

Pesia Tyt
St

Pasen e

Pasnnker

e e

sssgmt Ty [0

Sepit

SutOpon O

U

ST

a
i}
8
8¢






image10.jpeg

organaseen
PosonTyoe







image11.jpeg

B o

Athese Tines...

s SO T

Upon Completon...
iSave ol Output Flles
oo, N G
L






image12.jpeg

Roqust 0 tame

101, 20000101 10030, 20 -
10, 20050191 0030, 20
101, 20050101 0030, 200
101, 20050101 9040, 200
0, 20050101 93090, 200







image13.jpeg

P
e O

Upon Completon..
o o O Fles







image14.jpeg

0 e ———————

1.

0D EASN CREATE FILE
DOD_SMART_CREATE_FILE







image15.jpeg

X

Reptg Pt 0t ]
Rt rrodExd it ]
OgPadMSD.

(e

(=

mm






image16.jpeg

Athose T,

oo T (TR

Upon Complotion.

S 1Ot Fs

- —
o G
e (T







image17.jpeg

Botosh Data

Fnd Roguests

SubmtaNew Reguest.

100D Batch and Timecare Stondby 20060915 100090, 200610/
(3152009 [oaD Batch on Timecar omal (20060901 04030, 200610/
45279 0 Batch and Timecare| INormal —— [2007/91/01 00.90:0, 200702
[0521% __[oaD Bach and Timecare Mormal 20060901 2090, 200610/
ol Roquest View Degis 7
Cncel Roguest Digposics 5






image18.jpeg

Rofes Dt

FndReqests

Sttt s Now Reuas,

06D Bt and Timecr (Competed_omal 20509150090, 2050
816 [0 Batchand Tiecar (Completed_fomal__ 730309159130, 20310/
05288500 Batchand Tecar Completed_ormal 70050901 030, 20510
B[00 Bt nd Tiecar Conpleted_Nomal 207011090, 20712]
Fi527%0 {30 Bachand Timecor (Completed_fomal 20030901030, 20510/

Vi Dtgs.

Dgtostcs

|
{
|

View O,

Vi Log






image19.jpeg

evp1oee e Euplogee Mumber:Tic esservice; Oegani st ons o upecvisor Tisecard
BRaiCs CLINIC; 00232
BB cLINIC; 00232
RI100232-HAS JAX BRARCH CLINICS00202-H0S IAT BRINCH CLINIC;00232
(8:00232-PRARRACT;00232-PIARRACY; 023
782618, NV 00232- PRIRRACY;00232- PHARIACY; 002323
78261, HY00232-PRARRACT;00232-PAARRACY, 0020
782611, VY 00232-PRARNACY;00232-PHARIACY; 002323
125212:LTIHIVY;00212-CORIND SUITES00202-COBAMD SUITEZO02321KTLZ,
$25212:LTIHVY;00212-CONIND SUITE300202-COBAMD SUETE:00232:OKTLZ,







image20.jpeg

Ele Eat

w20 &







image21.jpeg

0 Q BEG P " jumiE —

B e ey oy ey

R OR et S0  SL - 4 s LA s A, RS S







image22.jpeg

Lol e3¢ vew Favorres

pen o

w

P e
Prntprovn.

Senct
Inport andEsport.

Propeties
Work e
cise







image23.jpeg

Save Web P

Save i | L3 D60_Bach_and_Tinecad S v o# i@

)

MyRecet
Dlemens

]

(=

=

My Docuerts

My Congute

Fierme: (000 Bach ond Tneco Swun_00r ¥| e ]

Wgﬂ Svmstpr  [TeaFinCh 8 =

Ewodns  [Wedern Ercpeon Wadows) T







image24.jpeg

Microsoft Excel - Book!







image25.jpeg







image26.jpeg

s

Open







image27.jpeg

Text Import Wizard - Step 1 of 3

The Text Wizard has determined that your data i Deliited.

I this i correct, choose Next, or chooss the deta type that best descrbes your dats.
Originaldata type.
Choose the fils type that best describes your dats:

@ Blififsd - Characters such as commas or tabs separate each Feld
 Ficed pickh - Fieds are agned incolumns vith spaces betueen each feld
Startimportstrow: [ 2] Flegrign: | 497 OEMUnitedStates  v]

Preview o il C:\Documents and Se...|00D_Batch_and_Timecard_Status _200607 .

6393 ;1R ;KRNY;00232 1S JEX BRANCH CLINIC;00232
63931 ;ARIY;00232- NS JEX BRANCH CLINIC;00232
6393 1R ;ARNY;00252- NS JEX BRANCH CLINIC;00232
6393 ;MR ;ARNY;00232-NAS JAX BRANCH CLINIC;00232] o,

i
Erih

aployes NansTuployes Nomber;Ticle;Servics;Organizarion;Grous ﬂ

|

cancel







image28.jpeg

Text Import Wizard - Step 2of 3

This screen et youset the delnters your data contains, You can see.

how your text s afected i the previen below.
Delmters

I [ semkdon [ Conma

I space [ other: [ Text qualfir:

™ Teeat consecutive delmters as ane.

Data review

aployes Nameraployes llu-hu;n;h,!trvue;orgmuann.ﬂreu,Luj
1763930, ;ARIY /00232 NAS JAX BRANCH CLINIC;00232-1]
176393 MR £ARIY/0022-HAS JAX BRANCH. CLINIC :00232-5]
76393 M8 £ ARIY00232-NAS JAX BRANCH CLINIC ;002321
176393, ARIY /00232 HAS JAX_ BRANCH CLINIC;00232-5] |

o — |
ol | <pack Ersh







image29.jpeg

Text Import Wizard - Step 2 of 3

This screen et you set the delinters your data contains. You can see
how your text s ffected in the preview below.

betes I Treat consecutve delmters as ane.
Flb W semckn [ coms

e T other [ Text gualfir

Data preview
fuployes Hame [mployes Husber [licle Fervice proamizacion
93 R, BRI pozaz-uas aax BRANC
93 . B pozaz-mas aax BRANC
93 . BR pozaz-mas aax BRANC
293 . e  pozaz-uas aax erawc] |







image30.jpeg

Text Import Wizard - Step 3 of 3

This sreen ts you select each column and set Column data Format
the Data Format,  General

“General converts numerlc values to numbers, date | ( Text
vales to dates, and allemaining values tatext. |~ oy

advanced

Dot preview

Do not mport column (skip)

Es L L L L
uployes Mumber [licle Fervice Proanizavion
53 R, BRI pozsz-mas 7hX BRANC
353 R, pmr  pozsz-mas 2 BRanC
393 R, pmr  pozsz-mas aax BRaNC
353 m.  pmr  pozszoms aax emanc]

| — i
Cancel <k







image31.jpeg

=

i Gz @ ot s A3 i

S amwazme @ Com b A worse |

i omme @ ot G AT s
£ o G G FmAr SEETR 3
7 W Gmemes @ [ Jeworr.
‘ Ml amevmmes @ i ety Semor |
s W memmey @ ey ) s
o ER0 o Gmommor  ® T o
i Znu n omcommor  m Ao D D e AR Semor
i Eeo v omowmo @ kom0 AT Seror |
o Bir o ameotmoy  m Ko D TS S
i T an mmwmme m Ko Di AT s s
5 B Smwmme @ Ao Dt AT s
% Ewr e m A Ao D P AT REECR |
7 Zoe an Gmemmad X i Dt o i AR SR
i S Gmamee @ Ko D g ATE s s
i T mmamad @ Ao D g AT s
b T Gmaamed ® Ko D AT FEETE |
o o mmamed @ i Dy AFE feEcs
B oGt Gmcommon ki Ao g ATE S 3
2 Smce wan mcomEmor  m Ko DD AT rn s
£l SmCer v RCommon  m o D s AT s
= Soicet a Ommcowmon i s ATE s o
5 Sicer v Gmmcommon e Dt APR St
7 Smoer wan ncommon  m oDt AT s
£ o Gmosmas @ i Dt g ATE s s
i S Gmammas @ kit TR SO,
B Sexfol an mcHmos i Dt e D AR Jemor |
£l Semron wa Gmosmus @ Ko De o D g TR Serors |
74> pach and et st fir! i







image1.wmf




Determining Timecard Statuses




image32.jpeg

T 005 OLFb 206







image33.jpeg

Page Setup.







image34.jpeg

Custom Headr

Custom Footer.







image35.jpeg

Tofomateds sk betd, b el bt o
Toreet apae sttt e, e et

rsingornte b e dc e it ancd
ottt st e o, Toformt e et

crsrntbe b npeste Pzt

4 JJ JJ alglgl JJ

T 1

st







image36.jpeg

Eont:

Footstyle:

ol

—

[T Abadi MT Condensed | US

| Algerian
and

Underlne:

[one

Effects

I Stiethrough
I” Superscrt
™ Subscrpt

2™ J L_ﬁ
E—

™ ormal font

AaBbCcYyZz

Thisis a TrueType fonk, The same fonk wil be used on both your printer and your sreen.







image37.jpeg

Tofomateds skt betd, b el bt o
Torset s unbe, s, ot e, e it

stigornte b e doce e it ancd
ottt st e o, Toformt et

crsrnte b npeste Pz,

4 JJ JJ alglgl JJ

T 1

st







image38.jpeg

Page Setup

Page | Margins  Header/Footer | sheet |

FOR OFFICIAL USE ONLY







image39.jpeg

Custom Header

Custom Faoter. |







image40.jpeg

Tofomaet el ettt chose e bt

Toreatapaeunbe, it e, oo, leone, e st
et ok e o b, e s e s uton

Torsrt e s e Pt e, Tofrnt o pts e
rsinthe et bosnd s theFcnt e i,

A 88 Yol ol g







image41.jpeg

Fort s e

[arsl [ (10

[ AGea i Condorcedt 2] [rogir = [ 2]

I Ageian % ke HE |
2| looanac 2| [ =

Underine

one I~ tormalfort

effects

I Stttvough
I Superscrpt
I Suprt

AaBbCevyZz

Thiss  TrueType fon, The same font il beused on both your ke and your screen,

[ ] o |






image42.jpeg

Page Setup.

Page | Margins {FeaderiFonier || sheet |

FOR OFFICIAL USE ONLY print.
Header:
options,
FOR OFFICIAL USE ONLY

Custom Header. Custom Footer.

Eooter
FOR OFFICAL USE ONLY

FOR OFFICAL USE ONLY

Cancel






image43.jpeg

A__v i Englosee Name
7 3 O
T Erslingioee e Sovce  OpaviaGro —Lishon Spesa T fsn Ty Corgore ‘g s

= e T
= MmOeT NV mecommod s Ot et Dt Piay AR
b MECPT MW GIRCOmRON 2 o Ot Ot Py AFR
El W01 NAVY  ODRCURRU R Actve Dt At Dt Primny AIFR







image44.jpeg

e game:
e e

o o i)

3291
34291 cA
3508 o

R e

e sage







image45.jpeg

A R o S

S S TeR 15 NoT RUATE: e G s 500 COURTER SYETES,

Er:g'..??srm.‘ e syt s et o e sy actof 1974

R e o e cour of o bt
ol o dacsmre o e of s

e e B e

ALY 58 st A1 DISCLOSeD I STRICT

e 5 A s e secunen To o v Y

==







image46.jpeg

 ASDATOR) 0D NOTCE 1D CONENT BuTR
[ A AL R

[ ——

e
(Tt ooy s
T e T e e ettt

o
et e s s B 419

e e e e et

v

e o et e ik
T

e
e e e T S SIS

i)







image47.jpeg

. Department of Defense iDENTITY

) Military Health System il

This Websitehas been Publc ey Enabled

Please cick on “CAC Access" below to access the appicaion using your Common
Access Card (CAC),

TDOID  ate surethat your CAC s nsete ko the CAC reacer o that our identty
PKE st s vl b e webbrovser.

L

b CAG kb







image48.jpeg

S. Department of Defense: iDENTITY
) Military Health System el

been Publec Key Enabled

Please clck on "CAC Access” below to access the appicaton using your Common
Access Card (CAC),

DO s o5 i s oy
PKE it

L







image49.jpeg

US Dot of Dt joenTTY
Military Health System b

i

been Puble Key Enabled

Pleass clck on "CAC Access” baow to access the appliation using your Common
ccess Cara CAC).

DOD)  vase sure that your Chc s nsete o the CAC rear o tht your ety
PKE conficat s avaaief he ed ronser







image50.jpeg

US. Department f D JDENTITY
AUTHENTICATION
Military SERVICES

Please cick on "CAC Access" below fo access the agpication using your Common
Access Card (CAC).

DOD e smst it s oty ity

b1 CAG ke







image51.jpeg

S Deparument o D JDENTITY

Military Health System AlTENToATON.

has been Publc ey Enabied

Please cick on "CAC Access” below to access the appicaton using your Common
Access Card (CAC),

IO s sm oty A o e st oty
PKE okt et

LI







image52.jpeg







image53.jpeg

AccountDetals: SelctResponsibity
e hnors el it b o o h s P et by s s e

Responsity
St sty

Locss Lok undtom o
D s oes ANIONES
[
CuratonTge APFS
Rty e A Sy ¥







image54.jpeg

ORACLE Dicue s
oo it

=
WorkshertList

suren
o g st e s S5

P @

Rt

——

5

7 oo

oot







image55.jpeg

ORACLE Dicmctims
et

=
WorksheetList

sexen

s e et s e S

B e | —

Rt

(Gs)

| sy
5

(=
> Gurmtrn

B3 T
[

[
> S
P s s ke

@ rrTe—
IS P
(S e

slols oo o

P @ick st oo

[

[ R ———————

T e s G i e o 0|
iy

s s e o o

e

[ eree—————
s s o e P g Sy Ve s e

T e ——)
s e s s S o G
oy e i
s 0y s
e . S e R sl







image56.jpeg

ResukList

(i)
ey

L
AL

£

IS Pt s e it S5 BG]
R e ek e e e







image57.jpeg

ORACLE Dl
ey

By Tvcad S-Sy T S

s







image58.jpeg

ORACLE Docmnr Ve

ety P

Tiecnd S et TSt

s
b Pt

-y e
B e
)

—— ”,_,;u s
mavmesston woameswr  f

@







image59.jpeg







image60.jpeg

ORACLE Dl Viewr

Seach ndSect Popl roupHame L
P — - =

suxn

R
ey st

=)







image61.jpeg







image62.jpeg

Search and Select: People Group Name Li
Thi page enabies youto slect theparaneter vaes

Search

To fincithe value, slect a fiter inthe drap dawn st and erter]
utton

Searchby [ Starts witn v
Search for [W2nsAA% Go

Dcase senstive







image63.jpeg

Searnang et Pacpl Group o e
S it () (s

suen

s ®

() ()|







image64.jpeg







image65.jpeg

oRACLE Do View:

Search and Select: People Group Name Like.
Searen

Sexch o AR @
[T

Resuts

Availsble Setected







image66.jpeg

ORACLE Discaveree Viewer
Business nllgence.

Search and Select: People Group Name Like.
s o s st v st vikes

Search
T v st e i oS e it e 5 bt T e

Sewcnty (S vt ¥
Sewcnor VAR
[rm—

Resuts
Availsble Selected

e
st

WSan messcem svC

WSAR Ao SRS ABUSE RO

IWaBAA b SEe

WaAa suTouATEN

s
L= b

@







image67.jpeg







image68.jpeg

[y —

B s =

SeachandSect: Pople Group Nam L

e s s e s s &) &
susn

et o e P o e

St

(Ganal) (Soug)







image69.jpeg

Select







image70.jpeg

ORACLE e
ey

eyl

Bl T St Bnehl e St

Wotstees
R

g e

B | v

-

e

ieoenstn wamesss |

&







image71.jpeg

@ .

Search and Select Parent Oganizaton Equals
s g s st st bt s (o) ()

T o, st 3 0 dop dom st r o i o . ek ot Tsoe a3
it o hach 5 i 5 et

Sewcty cois ¥
Sevcrte ®
[

Rets

DI0SAALABULATORY CARE CONTER PORTSHOUTH 1
2SR

miRssEsS ERAS.
wiE20WROSUTE

DI EPUEIS NOWED AUHENT 8L
DIE20RANNSTRATON
DIG0RCLNCAL SUPPORTSERVCES
DIRORMEATH SEVCES
DIER0RCCOMMNTY HEATH
DIR0RRESURCES
DIREUATNAD AN
mia2sPRACICE

o
o
[
o
o
o
[
[
o
)
[
)
=







image72.jpeg

Search

To finithe vale, select a fiter nthe drop down st an|
and clk the go hutton

Search by | Starts with v

Search for [W2SAA%

Dcase senstive







image73.jpeg

ORACLE DisoreerViwer

Booestligecs =
Searchand Select Parent Organizaton Equale
e s et et e () ()

Sexeh

St At @
Demesone

Resuts







image74.jpeg

Reats

s 15 W

O WIS
O WPAROOHD PSTEH
0 RO B SEC

O VPAALERSY AN
0 wrmeaBs

O WP

© WA LOPERSIC

0 WPIAANESNSG SV








EASIV File Transfer

Top of Form

Quick Link 

Bottom of Form

Reference: DMHRSi Glossary List

Reference: LCA Monthly Sequence of Events 

[bookmark: ZZZ_TUT_1]Scope

This procedure covers the interim process for passing a monthly Defense Medical Human Resource System internet (DMHRSi) Expense Assignment System IV (EASIV) output file to the EASIV system. 

This procedure does not cover creation of the EASIV Extract file.  Refer to Create EASIV Extract File.   

[bookmark: ZZZ_TUT_2]Policy

Monthly close processes must be run in accordance with Service Specific Policy and Guidance.  

[bookmark: ZZZ_TUT_3]Responsibility

Responsibilities within DMHRSi are "Role" based.   All roles are responsible for monitoring Self Service worklist and notification.  Refer to Manage Your Worklist.  Your Role is defined by your assignment within your organization and reflects your security levels within DMHRSi.  The following roles may be assigned to any individual within an activity responsible for completing the following:

The DMHRSi Project Office is responsible for ensuring that the tasks defined are consistent with actual application functionality.

The DMHRSi Subcommittee is responsible for ensuring that the Policy and Responsibilities set forth in this document are consistent with Service policy and/or guidance.  

The LCA Specialist is responsible for 

· Creating a copy of the DoD EASIV Extract File output. 

· Providing a copy of the EASIV Extract File output to the Site System Administrator.  This can be accomplished using e-mail, CD, or other electronic means in accordance with site-specific policy. 

· Completing monthly EASIV processing in accordance with Service/site-specific policy. 

The LCA Manager is responsible for ensuring that the monthly EASIV processing is completed in accordance with Service and DoD policy. 

The Site System Administrator is responsible for posting the EASIV Extract File on the shared drive for EASIV processing in accordance with Service/site-specific policy.

[bookmark: ZZZ_TUT_4]Distribution

DMHRSi Configuration Control Board

DMHRSi Maintenance Contractor*

DMHRSi Project Office

DMHRSi Sub-Committee

LCA Manager

LCA Specialist*

[bookmark: ZZZ_TUT_5]Ownership

The DMHRSi Configuration Control Board is responsible for this document.  Changes to this document must follow the DMHRSi Configuration Management Process with final approval authority being the DMHRSi Configuration Control Board.

[bookmark: ZZZ_TUT_6]Activity Preface

This is an interim activity that will be performed monthly upon completion of EASIV processing in DMHRSi.  This process will be replaced by an automated process upon implementation of the web enabled version of EAS. 

You must log on to DMHRSi by typing in your assigned User Name and Password.  If you do not have an assigned account, please contact your Site Application Administrator (SAA).  

Since all entered data is case sensitive, turn the "CAPS LOCK" on now. 

Prior Activity

Create EASIV Extract File.    

[bookmark: ZZZ0002][bookmark: ZZZ_TUT_7]LCA Specialist

[bookmark: ZZZ0003]1.   Copy the EASIV output. 

Start the task using the "[Service] LCA Specialist" responsibility. 

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO129LC_temp_image002.jpg]

· Select the "View Requests" option under the Process and Reports node to open the "Find Requests" form. 

The “Find Requests” form opens.

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO129LC_temp_image004.jpg]

· Find the desired request.  

Note:  You can search for your requests using any of the following:

· My Completed Requests – will return all requests submitted using your user ID 

· My Requests in Progress – will return requests submitted using your user ID 

· All My Requests – will return any request you have submitted 

· Specific Requests – allows search to be further narrowed 

· Click on the “Specific Requests” radio button. 

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO129LC_temp_image006.jpg]

· Click on the “Name” field and type %EASIV%. 

· Click the “Find” Button. 

Note:  The following fields may also be used to narrow your search:

· Request ID – narrows to a specific request 

· Name – narrows search to specific request name (e.g. DoD EASIV Create File) 

· Date Submitted – narrows search to date request(s) submitted 

· Date Completed – narrows search to date request(s) completed 

· Status – narrows search to the a specific status (e.g. Normal, Error) 

· Phase – narrows search to a specific phase (completed, running, pending, or planned) 

· Requestor – narrows your search to one requestor (used if your responsibility has access to report for multiple requestors - such as a system administrator) 

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO129LC_temp_image008.jpg]

· Highlight the "Request ID" for the desired report and click the “View Output” button. 

Note:  The concurrent program output report displays the EASIV Extract file.

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO129LC_temp_image010.jpg]

· Copy and Save the Output File. 

· From the Toolbar, select Tools>Copy File. 

· The output file is presented in a separate browser window in HTML format. 

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO129LC_temp_image012.jpg]

· Select File>Save to save the file. 

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO129LC_temp_image014.jpg]

The “Save Web Page” window opens.

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO129LC_temp_image016.jpg]

· Change the file type to Text using the drop down menu in the “Save As Type” field. 

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO129LC_temp_image018.jpg]

· Enter a unique file name or accept the default file name in the File Name field. 

· Press the Save button to save the file.  The output file in text format is available for import to EASIV. 

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO129LC_temp_image020.jpg]

· Find and open the text file that you saved. 

[bookmark: ZZZ0004]2.   Transfer the file to the Site System Administrator.

[bookmark: ZZZ0005]DMHRSi Maintenance Contractor

[bookmark: ZZZ0006]If Army, goto task #3.

[bookmark: ZZZ0007]If Navy, goto task #4.

[bookmark: ZZZ0008]If Air Force, goto task #5

[bookmark: ZZZ0009]3.   Army Sites:

· Run the EAS SAS input process. 

· Determine file name to be used for FTP of the DMHRSi EASIV extract file. 

· Place the DMHRSi file on the site UCAPERS server and FTP the file to the site EASIV server.  

· Continue to process in accordance with existing Site-specific Policy. 

[bookmark: ZZZ0010]4.   Navy Sites:  

· Load the DMHRSi EAS output file to the current shared drive for EAS processing. 

· Continue to process in accordance with current Site Policy. 

[bookmark: ZZZ0011]5.   Air Force Sites:  

· Determine the location and file name to be used for the DMHRSi EASIV extract file. 

· Replace the current legacy flat file with the DMHRSi extract file. 

· Load the file to the EASIV server. 

· Continue to process in accordance with existing Site-specific Policy. 

[bookmark: ZZZ0012]End of activity.



[bookmark: TUT_FLOWCHART_1][bookmark: ZZZ_TUT_8][image: EASIV File Transfer: Flowchart]
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Run Payroll Reconciliation Reports

Top of Form

Quick Link 

Bottom of Form

Reference: DMHRSi Glossary List

Reference: Load The Payroll

Reference: LCA Monthly Sequence of Events

[bookmark: ZZZ_TUT_1]Scope

This procedure covers running the reports used to reconcile payroll data imported from an external payroll system into DMHRSi. 

The Raw Payroll records are imported into a staging table in DMHRSi.  The DOD Payroll Actuals Stage report is used to view the records in the DOD_ACTUALS_STAGE staging table. 

The DOD Payroll Actuals Worksheet report is used to view the records in the DOD_PAYROLL_ACTUALS table after the raw records are imported from the staging table and parsed into columns.  The Report lists the payroll records are for Civilian Employees from all Services and Army Local National employees. 

The DOD Employees Missing Payroll Data Worksheet is used to identify Civilian employees from all Services and Army Foreign National employees that are missing payroll data. 

The Service-specific Payroll Validation Report Worksheet is used to identify errors that occur when the payroll data is loaded.  This includes employees where payroll data was received and an employee record does not exist in DMHRSi.

The Mismatched Hours Report Worksheet is a summary report for the pay period.  It is used to identify Self Service Timecards for Civilian Employees from all Services and Army Local Nationals where the timecard hours do not match the payroll hours imported into DMHRSi. 

The Cost Reconciliation Report identifies Civilian Employees and Local National Employees where the hours and cost assigned to the approved employee timecards do not match the hours or cost from the payroll data.

The Leave without Pay Report identifies individuals who have "Leave with Pay" costs or hours from DCPS for the selected pay period.  Leave without Pay costs at zero in DMHRSi, and DCPS may contain Leave without Pay Costs, which will trigger a cost variance during reconciliation.  The intent of this report is to allow the user to verify the individuals that are on Leave without Pay to help reconcile cost variances.  

[bookmark: ZZZ_TUT_2]Policy

The payroll reconciliation is completed after all payroll files are imported for a bi-weekly pay period.

The hours and cost reconciliation are performed after all timecards are entered and approved and cost is assigned by running the PRC: Distribute Labor Cost Concurrent Program.

[bookmark: ZZZ_TUT_3]Responsibility

Responsibilities within DMHRSi are "Role" based.   All roles are responsible for monitoring Self Service worklist and notification.  Refer to Manage Your Worklist.  Your Role is defined by your assignment within your organization and reflects your security levels within DMHRSi.  The following roles may be assigned to any individual within an activity responsible for completing the following:

The DMHRSi Project Office is responsible for ensuring that the tasks defined are consistent with actual application functionality.

The DMHRSi Subcommittee is responsible for ensuring that the Policy and Responsibilities set forth in this document are consistent with Service policy and/or guidance.  

The LCA Specialist is responsible for reconciling the payroll information. 

The LCA Manager is responsible for identifying inaccuracies, making necessary corrections and/or adjustments as required, and running any necessary close processes within the DMHRSi application.

[bookmark: ZZZ_TUT_4]Distribution

DMHRSi Configuration Control Board

DMHRSi Project Office

DMHRSi Sub-Committee

LCA Manager

LCA Specialist*

[bookmark: ZZZ_TUT_5]Ownership

The DMHRSi Configuration Control Board is responsible for this document.  Changes to this document must follow the DMHRSi Configuration Management Process with final approval authority being the DMHRSi Configuration Control Board.

[bookmark: ZZZ_TUT_6]Activity Preface

Service-specific Gross Payroll Reconciliation (GPR) files are imported into DMHRSi, for more information Gross Payroll Reconciliation (GPR) files, refer to Load The Payroll.

Warning:  If any project expenditure or labor costs rate has been changed, the PRC: Distribute Labor Cost concurrent program must be run to recalculate the changes.   Refer to Distribute Labor Costs for procedures on how to run the Distribute Labor Cost concurrent program.

You must log on to Discoverer 4iViewer by typing in your assigned User Name and Password.  If you do not have an assigned account, please contact your Site Application Administrator (SAA).  

Since all entered data is case sensitive, turn the "CAPS LOCK" on now.  

[bookmark: ZZZ0001][bookmark: ZZZ_TUT_7]LCA Specialist

[bookmark: ZZZ0002]1. Access Discoverer Viewer from Internet Explorer at the following URL:

· Type the following URL https://dmhrsi.satx.disa.mil 

The “DoD Computer System Policy” message displays.

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO126LC_temp_image002.jpg]

· Read the policy and click the “OK”button. 

The “Oracle Rapid Release Install 11i” page displays.

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO126LC_temp_image004.jpg]

· Click the “Apps Logon Links.” 

The “Logon Options for Oracle Application 11i”” page displays.

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO126LC_temp_image006.jpg]

· Click on the “E-Business Home Page” link. 

The “DoD Computer System Policy” message displays.

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO126LC_temp_image008.jpg]

· Read the policy and click the “OK”button. 

The “U.S. Department of Defense Military Health System, iDENTITY AUTHENTICATION SERVICES message, This Website has been Public Key Enabled” selection page displays.  

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO126LC_temp_image010.jpg]

Select one of the appropriate methods of use to access the application.

If you have an active DoD Common Access Card, select: 

· CAC Access:   This will validate the use of CAC access to the application. You must have a valid PKI certificate, a trusted PKI Common Access (CA) certificate should be installed, and CAC middleware must be installed and configured properly on your work station (only applicable if you are using a DoD common access card). 

If you do not have a DoD Common Access Card or if your card is not functioning properly, select:

· If you don’t have a CAC, click here:  If you do not have a CAC Card or if your CAC card is not working properly, you can still logon directly by using your Username and Password. 

[bookmark: ZZZ0003]If validating your CAC card, goto task #2. Otherwise, goto task #3.  To bypass the CAC card, enter your Username and Password directly.

[bookmark: ZZZ0004]2. Validate your CAC Card to access the application. 

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO126LC_temp_image011.jpg]

· Click the “CAC Access” button. 

The “Choose a digital certificate” displays.

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO126LC_temp_image013.jpg]

· Select the appropriate certificate. 

· Click the “OK” button. 

The “ActivClient Login” form displays.  

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO126LC_temp_image015.jpg]

· Enter your PIN number in the “Pin” field. 

· Click the “OK” button. 

Warning:  If your DoD CAC was not validated, click the back button on the browser to return to the CAC selection page to access the application using the “If you don’t have a CAC, click here” option.

[bookmark: ZZZ0005]Goto task #4.

[bookmark: ZZZ0006]End of activity.

[bookmark: ZZZ0007]3. Bypass your CAC Card to access the application’s Username and Password.

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO126LC_temp_image016.jpg]

· Click the “If you don’t have a CAC, click here” link. 

[bookmark: ZZZ0008]4. Login to Discoverer Viewer.

The “Discoverer Viewer” page opens.

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO126LC_temp_image018.jpg]

· Connect To:  Accept the default “Oracle Applications” from the list of values. 

· User Name:  Enter your DMHRSi Applications User Name. 

· Password:  Enter your DMHRSiApplications Password. 

· Database:  Enter the Database as “PROD.” 

· Click the “Go” button. 

· Sign in to Discoverer Viewer. 

· Connect To:  Accept the default “Oracle Applications” from the list of values. 

· User Name:  Enter your DMHRSi Applications User Name. 

· Password:  Enter your DMHRSiApplications Password. 

· Database:  Enter the Database as “PROD.” 

· Press the “Go” button. 

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO126LC_temp_image020.jpg]

[bookmark: ZZZ0009]5. Open the LCA Reconciliation Reports workbook.

· Start the task by using the "[Service] LCA Specialist" responsibility. 

Note:  The "[Service] LCA Manager" responsibility may also be used to perform these tasks. 

· Click the "Continue" button. 

Note:  The Workbook Result List will be collapsed on your initial entry to Discoverer.

The "Worksheet List" form displays.

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO126LC_temp_image022.jpg]

· Open the “Discoverer Workbooks” by clicking on the “Expand All” link. 

Note:  The screen below lists all the workbooks that are available in Discoverer Viewer.  The “Workbooks” displayed depend on your role and reports shared to your role.  If you need access to other responsibilities (reports), please request access through your local policy.

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO126LC_temp_image024.jpg]

· Open the LCA Reconciliation Reports Workbookin Discoverer Viewer by clicking on blue arrow next to the workbook name. 

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO126LC_temp_image026.jpg]

[bookmark: ZZZ0010]6. Run the DOD Payroll Act Stage Report.

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO126LC_temp_image028.jpg]

· Select the "DOD Payroll Act Stage"worksheet from the list of worksheets by clicking on the worksheet name.  

The report allows you to view the raw records imported into the Payroll Staging table from the GPR file. 

Note:  Discoverer settings are setup to run the query upon selection.

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO126LC_temp_image030.jpg]

· View the raw records in the staging table. 

Note:  Use the horizontal and/or vertical slide bars to bring remaining fields into view.

The "Worksheets" form is still active.

· Upon completion, perform one of the following actions: 

· To run another report, simply select another worksheet from the current report displayed. 

· Click the “Workbook” link in the left hand corner of the "Worksheets” form to navigate back to the “Worksheet List” page. 

· Click the "Exit" link in the upper right corner of the "Worksheets" form to exit. 

[bookmark: ZZZ0011]7. Run the DOD Payroll Actuals Report.

· Select the DOD Payroll Actuals Worksheetfrom the worksheets list by clicking on the worksheet name. 

The DOD Payroll Actuals Worksheet lists the payroll records in the DOD_PAYROLL_ACTUALS table for Civilian Employees for all Services and Army Local National Employees after the raw records in the staging table have been parsed into the proper columns.

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO126LC_temp_image032.jpg]

· Note:  If your Discoverer Viewer Options are not set up to, prompt before running the query, you may be automatically taken to the "Parameters" page. 

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO126LC_temp_image034.jpg]

· Enter the "Parameters Needed" for the report: 

To view the report for an individual employee and pay period end date, enter the following parameters:

Pay Period End Date:  Enter the "Pay Period End Date" using the DD-MON-YYYY format (09-JAN-2007).

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO126LC_temp_image036.jpg]

· SSN:  Enter the individual's Social Security Number (SSN), including dashes. 

· Click the “Go” button to run the report.  The Workbook query "Progress page" displays while the query is executing. 

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO126LC_temp_image038.jpg]

· Review the DOD Payroll Actuals Report. 

To view the report for all employees where the employee Social Security Number (SSN) starts with “111” for the Pay Period End Date, enter the following parameters:

Pay Period End Date:  Enter the "Pay Period End Date" using the DD-MON-YYYY format (09-JUN-2007).

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO126LC_temp_image040.jpg]

SSN:  Enter the beginning of the SSN followed by the percent sign “%.”  In the example below, the Pay Period End Date parameter 09-JUN-2007 was used in combination with SSN with a parameter of “111%.”

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO126LC_temp_image042.jpg]

Note:  Use the “Right” link to bring remaining fields into view.

· Review the DOD Payroll Actuals Report. 

The "Worksheets" form is still active.

· Upon completion, perform one of the following actions: 

· To run another report, simply select another worksheet from the current report displayed. 

· Click the “Workbook” link in the left hand corner of the "Worksheets” form to navigate back to the “Worksheet List” page. 

· Click the "Exit" link in the upper right corner of the "Worksheets" form to exit. 

[bookmark: ZZZ0012]8. Run the DOD Employees Missing Payroll Data Report.

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO126LC_temp_image044.jpg]

· Select the DOD Employees Missing Payroll Data Worksheet from the worksheets list by clicking on the worksheet name.  

The report lists the Civilian Employees for all Services and Local National Employees for the Army in DMHRSi who do not have payroll data in the Payroll Actuals table for the pay period.  If you are missing payroll data, please contact your System Administrator. 

You may enter an Employee Cost Rate for any employee that is missing payroll data.  Refer to Enter and Maintain Employee Cost Rates.

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO126LC_temp_image046.jpg]

· Enter parameters for the report: 

Pay Period End Date =:   Enter the Pay Period End Date in the "Pay Period End Date = " parameter using the DD-MON-YYYY format.  

Parent DMIS ID:  Enter the Parent DMIS ID in the "Parent DMIS ID" parameter field.

· Click the “Go” button to run the report.  The "Query Progress" page displays while the query is executing.   

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO126LC_temp_image048.jpg]

Warning:  Continue to run the query? "This query is estimated to take xxx seconds to complete." 

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO126LC_temp_image050.jpg]

· Click the "Yes" button to run the report. 

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO126LC_temp_image052.jpg]

· View the Payroll Reconciliation Report. 

The "Worksheets" form is still active.

· Upon completion, perform one of the following actions: 

· To run another report, simply select another worksheet from the current report displayed. 

· Click the “Workbook” link in the left hand corner of the "Worksheets” form to navigate back to the “Worksheet List” page. 

· Click the "Exit" link in the upper right corner of the "Worksheets" form to exit. 

[bookmark: ZZZ0013]9. Run the Service-specific Payroll Validation Report.

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO126LC_temp_image054.jpg]

· Select the Payroll Validation Report- Servicefrom the worksheets list by clicking on the worksheet name.  

The report lists the payroll records that were loaded into DMHRSi with an error status.  These may include the following:

· Employees in the Payroll Actuals table that do not have a corresponding employee record in DMHRSi.  Employees must be entered in DMHRSi when the payroll is validated.  The payroll may have been charged in error. 

· Pay codes that could not be validated in the DOD_CONS_PAYCODES quick lookups.  To load a pay code for validation, refer to Maintain Paycodes Values. 

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO126LC_temp_image056.jpg]

· Enter the Parameters  Needed for the report: 

Pay Period End Date:  Enter the "Pay Period End Date" using the DD-MON-YYYY (uppercase) format.

Parent DMIS ID:  Enter your facility's Parent DMIS ID code. 

· Click the "Go" button to run the report. 
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· View the Payroll Validation Report. 

· Upon completion, perform one of the following actions: 

· To run another report, simply select another worksheet from the current report displayed. 

· Click the “Workbook” link in the left hand corner of the "Worksheets” form to navigate back to the “Worksheet List” page. 

· Click the "Exit" link in the upper right corner of the "Worksheets" form to exit. 

[bookmark: ZZZ0014]10.    Run the Mismatched Hours Report.
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· Select the Mismatched Hours Worksheet from the worksheets list by clicking on the worksheet name. 

The report lists the Self Service timecards in DMHRSi where the hours on the timecard do not match the hours in the payroll data for the pay period.  Reasons may include the following:

· Self Service timecards that were submitted for the pay period but waiting to be approved by the Timekeeper for the People Group Organization of the employee, and the hours on the timecard do not match the payroll hours.  The timekeeper must approve the timecards in Self Service. 

· Self Service Timecards for the pay period rejected because the timecard hours do not match the payroll hours.  The employee must correct and re-submit the rejected timecards. 

Note:  If the hours on all Self Service Timecards during the pay period match the payroll hours, the report will not produce a result set.

Note:  Timecards are weekly and the payroll data is bi-weekly.  Each payroll period includes two weekly timecards.
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· Enter the parameters for the report: 

Pay Period End Date:  Enter the "Pay Period End Date" using the DD-MON-YYYY (uppercase) format.

DMIS ID:  Enter the Parent "DMIS ID" code for your facility.

· Click the “Go” button to run the report.  The "Query Progress" page displays while the query is executing.  
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Warning: Continue to run the query? "This query is estimated to take xxx seconds." 
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· Click the "Yes" button to run the report. 
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· View the Mismatched Hours Report. 

The "Worksheets" form is still active.

· Upon completion, perform one of the following actions: 

· To run another report, simply select another worksheet from the current report displayed. 

· Click the “Workbook” link in the left hand corner of the form to navigate back to the “Worksheet List” page. 

· Click the "Exit" link in the upper right corner of the "Worksheets" form to exit. 

[bookmark: ZZZ0015]11.    Open the LCA Cost Reconciliation workbook.
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· Open the LCA Cost Reconciliation Workbookin Discoverer Viewer by clicking on the blue arrow next to the workbook name. 

[bookmark: ZZZ0016]12.    Run the Cost Reconciliation Report.
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· Select the Cost Reconciliation Worksheetfrom the workbook list by clicking on the worksheet name. 

This Discoverer report lists the employees in DMHRSi where the cost assigned to the timecard does not match the cost in the payroll data for the pay period.  Reasons may include:

· A duplicate timecard was entered for the employee.  Duplicate timecards can only be entered for the employee using Pre-Approved Batch. 

· Timecard(s) is in the Working, Submitted, Rejected, or Approved status and cost has not been assigned.  The timecard must be completed, submitted, and approved, and the costing process must run to assign cost. 

Note:  This report is run after all timecards are completed for the payroll period and the Distribute Labor Cost process has been run to assign cost to the timecards.  The results set include both Self Service and Pre-approved Batch Timecards. 

Note:  If all timecard hours and cost for the pay period match the payroll hours and cost for the pay period, the report will not produce a result set.

Note:  Timecards are weekly and the payroll data is bi-weekly.  Each payroll period includes two weekly timecards.

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO126LC_temp_image074.jpg]

· Enter the Parameters Needed for the report: 

Pay Period End Date:  Enter the "Pay Period End Date" using the DD-MON-YYYY (uppercase) format.

Parent DMIS ID:  Enter the "Parent DMIS ID" parameter for your facility.

Cost Variance Greater than or Equal to:  Enter the lowest “Cost
Variance” amount in dollars and cents.  Note:  Enter the amount you wish to see on the report (e.g., entering $0.01 allows the user to enter a value so that a record will appear on the report but only if the difference between the DCPS and DMHRSi cost numbers exceed the value that was entered in the parameter.  It displays results when there is a difference between the hours or costs, greater than the parameter that was entered.   If the value is set to $0.00, all records will display).

· Click the “Go” button to run the report.  The "Query Progress" page displays while the query is executing.  
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· View the Cost Reconciliation Report. 

The "Worksheets" form is still active.

· Upon completion, perform one of the following actions: 

· To run another report, simply select another worksheet from the current report displayed. 

· Click the “Workbook” link in the left hand corner of the "Worksheets” form to navigate back to the “Worksheet List” page. 

· Click the "Exit" link in the upper right corner of the "Worksheets" form to exit. 

[bookmark: ZZZ0017]13.    Run the Leave without Pay worksheet.

· Select the Leave without Pay Worksheetfrom the workbook list by clicking on the worksheet name. 

The "Leave without Pay" Report identifies those individuals who have Leave with pay costs or hours from DCPS for the selected pay period.  Leave without pay is costed at zero in DMHRSi, and DCPS may contain "Leave without Pay" Costs, which will trigger a cost variance during reconciliation.  The intent of this report is to allow the user to verify these individuals that are on "Leave without Pay" to help reconcile cost variances.  

[image: https://dmhrsi.satx.disa.mil/pls/PDMHRI/fndgfm/fnd_help.get/US/FND/PRO126LC_temp_image078.jpg]

· Enter the Parameters Needed for the report: 
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Parent DMIS ID:   Enter the "Parent DMIS ID" code for your facility.

Pay Period End Date:   Enter the "Pay Period End Date" using the DD-MON-YYYY (uppercase) format.
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· Click the “Go” button to run the report.  The "Query Progress" page displays while the query is executing.  
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· View the Cost Reconciliation Report. 

The "Worksheets" form is still active.

· Upon completion, perform one of the following actions: 

· To run another report, simply select another worksheet from the current report displayed. 

· Click the “Workbook” link in the left hand corner of the "Worksheets” form to navigate back to the “Worksheet List” page. 

· Click the "Exit" link in the upper right corner of the "Worksheets" form to exit. 

[bookmark: ZZZ0018]14.    Run the ID Sub Query for LWOP worksheet.

· Select the ID Sub Query for LWOP Worksheet from the workbook list by clicking on the worksheet name. 

This worksheet is required to enable other worksheets.  It is of no value in and of itself.

Note:  Discoverer settings are setup to run the query upon selection.
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The "Worksheets" form is still active.

· Upon completion, perform one of the following actions: 

· To run another report, simply select another worksheet from the current report displayed. 

· Click the “Workbook” link in the left hand corner of the "Worksheets” form to navigate back to the “Worksheet List” page. 

· Click the "Exit" link in the upper right corner of the "Worksheets" form to exit. 

[bookmark: ZZZ0019]End of activity.



[bookmark: TUT_FLOWCHART_1][bookmark: ZZZ_TUT_8][image: Run Payroll Reconciliation Reports: Flowchart]
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